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Learn more

This guide and other resources for SMART Document camera 650 are available in the 

Support section of the SMART website (smarttech.com/support). Scan this QR code to 

view these resources on your mobile device.

FCC warning

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the manufacturer’s instructions, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Trademark notice

SMART Board, smarttech, the SMART logo and all SMART taglines are trademarks or registered trademarks of SMART Technologies ULC in the U.S. and/or other countries. All third-
party product and company names may be trademarks of their respective owners.

Copyright notice

© 2021 SMART Technologies ULC. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any 
language in any form by any means without the prior written consent of SMART Technologies ULC. Information in this manual is subject to change without notice and does not 
represent a commitment on the part of SMART.

This product and/or use thereof is covered by one or more of the following U.S. patents:

www.smarttech.com/patents

April 7, 2021
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Important 
information

WARNING 

 l Failure to follow the installation instructions included 
with the SMART product could result in injury and 
product damage which may not be covered by the 
warranty.

 l Ensure that any cables that cross the floor to the SMART 
product are properly bundled and marked to avoid a trip 
hazard.

 l Do not puncture, crush, heat or disassemble the battery, 
expose it to fire or any liquid, short its terminals, or 
abuse the battery in any other way as this may cause the 
battery to explode or ignite, and could cause a fire or 
injury.

 l Don’t install the battery backwards or reverse the 
polarity. Don’t install other types of battery in the remote 
control. Both of these actions can cause damage to the 
remote control and can cause a fire or injury.

 l To reduce the risk of fire or electric shock, do not 
expose the SMART product to rain or moisture.

 l Do not push foreign objects into the openings on your 
SMART product.

 l Do not open or disassemble the SMART product. You 
risk electrical shock from the high voltage inside the 
casing. Opening the casing also voids your warranty.

 l The camera arm on your SMART product has joint that 
present a pinch hazard when your move the camera 
arm. Keep clear of the pinch points.

 l Do not stare into the light or shine the light directly into 
someone’s eyes. Turn off the light when capturing 
images of people.

 l Do not overload power outlets or extension cords as 
this can result in a fire or electric shock.

 l Turn off and disconnect your SMART product before a 
thunderstorm. During a thunderstorm, do not touch your 
SMART product or the plug, because there is a risk of 
electrical shock.

 l Only use your SMART product with the type or power 
source that is written on the power supply and do not 
modify the plug.

 l Do not short circuit or allow contract with conductive 
objects to the battery terminals.

 l Do not disassemble batteries.

CAUTION 

 l Place your SMART product on a solid surface to prevent 
it from falling.

 l If you have a security cable attached to your SMART 
product, do not carry or swing your SMART product by 
the security cable.

 l Do not connect non-shielded interface cables to your 
SMART product and do no leave cables connected to 
unused connectors, because this can cause 
interference level that exceed FCC regulations.

 l Avoid setting up and using the SMART product in an 
area with excessive levels of dust, humidity and smoke.

 l Do not block or cover the opening or slots on your 
SMART product. These slots provide ventilation, ensure 
reliable operation and protect your SMART product from 
overheating.

 l Do not carry your SMART product by the camera arm. 
Carry it by the base of the unit.

 l Do not aim the camera lens at the sun.

 l If the SMART product requires replacement parts, make 
sure the service technician uses replacement parts 
specified by SMART Technologies or parts with the 
same characteristics as the original.

 l Ensure that batteries are stored in a cool and dry place.

 l Do not discard batteries in water, fire, or domestic 
waste. Dispose batteries at collection points.

 l Remove the batteries in the remote control if you are not 
in for an extended period of time. Battery corrosion or 
leakages can damage the remote control.

 l Do not mix new and used batteries.

 l Do not mix different types of batteries: alkaline, nickel-
cadmium (rechargeable), or carbon-zine.

Federal Communication Commission 
Interference Statement
This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions:

 1. This device may not cause harmful interference, and

 2. this device must accept any interference received, 
including interference that may cause undesired 
operation.

This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate 
radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications.
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However, there is no guarantee that interference will not occur in 
a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one of the 
following measures:

 l Reorient or relocate the receiving antenna.

 l Increase the separation between the equipment and 
receiver.

 l Connect the equipment into an outlet on a circuit different 
from that to which the receiver is connected.

 l Consult the dealer or an experience radio/TV technician 
for help.

CAUTION 

Any changes or modifications not expressly approved by the 
party responsible for compliance could void the user’s 
authority to operate this equipment.

This transmitter must not be co-located or operating in 
conjunction with any other antenna or transmitter.

For operation within 5.15 ~ 5.25GHz / 5.47 ~5.725GHz 
frequency range, it is restricted to indoor environment. The 
band from 5600-5650MHz will be disabled by the software 
during the manufacturing and cannot be changed by the end 
user. This device meets all the other requirement specified in 
Part 15E, Section 15.407 of the FCC Rules.

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set 
forth for an uncontrolled environment. This equipment should be 
installed and operated with minimum distance of 20cm between 
the radiator & your body.

FCC

Supplier’s Declaration of Conformity

47 CFR § 2.1077 Compliance Information

Unique Identifier: SDC-650, WD650

Responsible Party – U.S. Contact Information

SMART Technologies Inc.

2401 4th Ave, 3rd Floor

Seattle,WA 98121

compliance@smarttech.com

Innovation, Science, and Economic 
Development Canada Statement
This device complies with RSS-210 of the Industry Canada Rules. 
Operating is subject to the following two conditions:

 1. This device may not cause harmful interference, and

 2. this device must accept any interference received, 
including interference that may cause undesired 
operation.

Ce dispositif est conforme à la norme CNR-210 d’Industrie 
Canada applicable aux appareils radio exempts de licence. Son 
fonctionnement est sujet aux deux conditions suivantes:

 1. le dispositif ne doit pas produire de brouillage 
préjudiciable, et

 2. ce dispositif doit accepter tout brouillage reçu, y compris 
un brouillage susceptible de provoquer un fonctionnement 
indésirable.

CAUTION 

 i. the device for operation in the band 5150-5250 MHz is 
only for indoor use to reduce the potential for harmful 
interference to co-channel mobile satellite systems;

 ii. the maximum antenna gain permitted for devices in the 
bands 5250-5350 MHz and 5470-5725 MHz shall 
comply with the e.i.r.p. limit; and

 iii. the maximum antenna gain permitted for devices in the 
band 5725-5825 MHz shall comply with the e.i.r.p. limits 
speci"ed for point-to-point and non point-to-point 
operation as appropriate.

 iv. Users should also be advised that high-power radars 
are allocated as primary users (i.e. priority users) of the 
bands 5250-5350 MHz and 5650-5850 MHz and that 
these radars could cause interference and/or damage to 
LE-LAN devices.

Avertissement:

 i. Le guide d’utilisation des dispositifs pour réseaux locaux 
doit inclure des instructions précises sur les restrictions 
susmentionnées, notamment :

 ii. les dispositifs fonctionnant dans la bande 5 150-5 250 
MHz sont réservés uniquement pour une utilisation à 
l’intérieur a"n de réduire les risques de brouillage 
préjudiciable aux systèmes de satellites mobiles utilisant 
les mêmes canaux;

 iii. le gain maximal d’antenne permis pour les dispositifs 
utilisant les bandes 5 250-5 350 MHz et 5 470-5 725 MHz 
doit se conformer à la limite de p.i.r.e.;

 iv. le gain maximal d’antenne permis (pour les dispositifs 
utilisant la bande 5 725-5 825 MHz) doit se conformer à la 
limite de p.i.r.e. spéci"ée pour l’exploitation point à point et 
non point à point, selon le cas.

 v. De plus, les utilisateurs devraient aussi être avisés que les 
utilisateurs de radars de haute puissance sont désignés 
utilisateurs principaux (c.-à-d., qu’ils ont la priorité) pour les 
bandes 5 250-5 350 MHz et 5 650-5 850 MHz et que ces 
radars pourraient causer du brouillage et/ou des 
dommages aux dispositifs LAN-EL.

Radiation Exposure Statement:

This equipment complies with ISED radiation exposure limits set 
forth for an uncontrolled environment. This equipment should be 
installed and operated with minimum distance of 20 cm between 
the antenna of this device and all nearby persons.

https://www.smarttech.com/kb/171733
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Déclaration d'exposition aux radiations:

Cet équipement est conforme aux limites d’exposition aux 
rayonnements ISED établies pour un environnement non 
contrôlé.Cet équipement doit être installé et utilisé avec un 
minimum de 20 cm de distance entre la source de rayonnement 
et votre corps.

EU Declaration of Conformity
Hereby, SMART Technologies ULC declares that the ratio 
equipment type Wireless AC Dual Band Adapter, WD650 is an 
compliance with Directive 2014/53/EU. The full text of the EU 
declaration of conformity is available at the following internet 
address: smarttech.com/compliance.

WARNING 

This equipment is compliant with Class A of CISPR 32. In a 
residential environment, this equipment may cause radio 
interference.

The frequency band and the maximum transmitted power in EU 
are listed below:

Transmitting Band 
(MHz)

Maximum Transmit Power EIRP 
(dBm)

2400-2483.5 20

5180- 5320 19

5500-5700 21

Restrictions in (5GHz)

AT/BE/BG/CZ/DK/EE/FR/DE/IS/IE/IT/EL/ES/CY/LV/LI/LT/LU/HU/M
T/NL/NO/PL/PT/RO/SI/SK/TR/FI/SE/CH/UK/HR. 5150MHz-
5350MHz is for indoor use only.

CAUTION: EXPOSURE TO RADIO FREQUENCY 

RADIATION

This equipment complies with EU radiation exposure limits set 
forth for an uncontrolled environment. This equipment should 
be installed and operated with minimum distance 20 cm 
between the radiator and your body.

Hardware environmental compliance
SMART Technologies supports global efforts to ensure that 
electronic equipment is manufactured, sold and disposed of in a 
safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment 
regulations (WEEE and Battery Directive)
Electrical and electronic equipment and batteries 
contain substances that can be harmful to the 
environment and to human health. The crossed-out 
wheeled bin symbol indicates that products should be disposed 
of in the appropriate recycling stream and not as regular waste.
 

Batteries
The SMART Document Camera 650 contains rechargeable 
lithium-ion batteries. The remote contains two AAA batteries. 
Recycle or dispose of batteries properly.

See smarttech.com/compliance for more information.

https://www.smarttech.com/kb/171733
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About this guide
This guide is for users who set up and use the SMART Document Camera 650 in their organizations.

It includes information about setting up the document camera and using the document camera’s on-screen 

display menu and software.

For more information, such as videos, training, and how-to topics, visit 

support.smarttech.com/docs/redirect/?product=doccamera650.

https://www.smarttech.com/kb/171733
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Features
The SMART Document Camera 650 connects digital learning to the physical world. This easy-to-use 4K 

Ultra HD visualizer captures live video and images directly to the SMART Board® interactive display, SMART 

Notebook® software, or your desktop. The SDC-650 is a fully UVC-compliant camera with built-in 

microphone that can be used as a high-quality webcam with SMART Board displays, keeping the continuity 

of a classroom experience even while video conferencing.

The document camera includes the following features:

Feature Details

Camera  l High resolution CMOS sensor

 l 23x digital zoom

 l Up to 60 frames per second

 l Automatic, manual, or area focus

 l Maximum shooting area 17 4/8" × 9 6/8"

Output/input  l HDMI 4K, 1080p @ 50 Hz / 60  Hz, 720p @ 50 Hz / 60 Hz

 l USB mini-B (for connecting to a computer)

 l USB 2.0 Type A (with pre-installed Wi-Fi dongle)

 l USB 2.0 Type A (for a USB storage device)

Physical 
construction

 l Built-in battery

 l Built-in LED illumination lamp

 l Anti-theft slot 

 l Mechanical arm

 l Integrated microphone in base

Software  l Supports the following software on a connected Windows or macOS computer:

 o SMART Notebook 20.1 or later collaborative learning software (includes 
SMART Ink and Product Drivers)

 o SMART Document Camera 650 software

Image and video 
storage

 l Supports USB storage

https://www.smarttech.com/kb/171733
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Components
The SMART Document Camera has a flexible arm for positioning the lens at any angle. The camera head has 

LED overhead lighting to enhance lighting conditions.

The SMART Document Camera 650 consists of the following components:

No. Name

1 Camera head

2 LED light

3 Camera arm

4 IR sensor

5 Control panel

6 Built-in mic

7 Front panel

8 Right panel

9 Handle

https://www.smarttech.com/kb/171733
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Control panel
The control panel to enables you to switch among Camera, Computer Pass-Through, and Playback modes. 

You can also use the control panel to adjust the settings and features in the Camera mode’s on-screen 

display (OSD) menu. 

The document camera’s control panel consists of the following:

No. Name More information

1 Power/Power indicator  l Turn the document camera ON/OFF 

 l Power indicator:

 o Solid red: Standby

 o No light: Power off

 o Solid green: Power on

2 Wi-Fi connection 
indicator

 l Solid blue: P2P / Wi-Fi Mode Ready

 l Slow flashing blue: Camera is connected to the SMART Document Camera software 

 l Short flashing blue: Connecting to Wi-Fi

 l Quick flashing green: Scanning for a Miracast device

 l Slow flashing green: Starting Miracast stream

 l Solid green: Connected to a Miracast device

3 Zoom in/out

and

Navigate up/down

 l Increase or decrease the image magnification in Camera mode

 l Access options from the OSD menu

4 Brightness 
increase/decrease

and

Navigate left/right

 l Increase or decrease the level of brightness when capturing a live images

 l Access options from the OSD menu

https://www.smarttech.com/kb/171733
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No. Name More information

5 Auto-Focus / Select  l Automatically adjust focus

 l Selection option for Playback mode and OSD menu

 l Start or pause video playback

6 Wi-Fi/USB mode  l Switch between using Wi-Fi or the USB connection mode

7 Record  l Start or stop recording video and audio

8 Freeze  l Pause or resume an image frame in Camera mode

9 Lamp  l Turn the overhead light  ON/OFF

10 Capture  l Capture an image in Camera mode

11 Info  l Access the on-screen display (OSD) menu

12 Camera/PC mode  l Switch the video signal between Camera  and Computer Pass-Through (PC) modes 
(see Understanding Camera and PC modes on page 15)

Right panel

The right panel of the document camera consists of the following: 

No. Name More information

1 HDMI input  l Use to connect a computer to the document camera

2 HDMI output  l Use to connect to an external display (monitor, projector, or interactive display)

3 DC power jack  l Use to recharge the document camera’s battery

https://www.smarttech.com/kb/171733


Chapter 1
Welcome

smarttech.com/kb/171733 12

Front panel

The front panel of the document camera consists of the following: 

No. Name More information

1 Battery charge indicator  l Solid green: 

 o Three power bars: battery is fully charged

 o Two power bars: battery is 30 to 60% charged

 o One power bar: battery is 5 to 30% charged

 l Solid red: Battery is 0 to 5% charged

 l Flashing red: Battery is out of power

 l Solid orange: Battery needs servicing; contact SMART support

2 USB mini port  l Port for connecting the document camera to a computer using a USB connection

3 USB port  l Port for a USB flash drive

4 Wi-Fi dongle receiver  l Receiver for the Wi-Fi dongle 

5 Anti-theft slot  l Attachment for a Kensington compatible lock 

https://www.smarttech.com/kb/171733
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Remote control
All features of the SMART Document Camera 650 can be accessed with the remote control. The remote 

control requires two AAA batteries.

No. Name More information 

1 Power  l Turn the document camera ON/OFF

2 WiFi/USB  l Switch between Wi-Fi and USB connection mode

3 Mute  l Mute the volume

4 Camera/PC mode  l Switch the video signal between Camera  and PC modes (see Understanding Camera 
and PC modes on page 15)

5 Capture  l Capture still image in Camera mode. When in continuous capture mode, press this 
button again to stop.

6 Record  l Start or stop recording video and audio

NOTE 

Video recording can be saved to a connected USB drive or a connected computer 
only when using SMART Notebook or SMART Document Camera 650 software.

https://www.smarttech.com/kb/171733
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No. Name More information 

7 Resolution  l Press to switch among the following modes:

 o Auto detect

 o 1024 × 768 (if the HDMI device supports it)

 o K 60Hz (if the HDMI device supports it)

8 Freeze  l Pause or resume an image frame in Camera mode

9 Auto-Exposure lock  l Lock the exposure to stop the document camera from adjusting the exposure 
automatically

10 Lamp  l Turn the overhead light ON/OFF

11 Rotate  l Rotate an image in Camera mode

12 Mode  l Switch among Normal, High frame, High quality, Microscope, Infinity, or Macro modes.

13 Delete  l Delete image or video in Playback mode

14 Info  l Press to view system information and battery status

15 Select  l Press to make a selection

16 Navigate  l Navigate through the on-screen display menu (OSD)

17 Auto-focus  l Automatically adjust focus

18 Zoom In/Out  l Increase or decrease the image magnification on camera and picture Camera mode

19 Volume  l Adjust the volume

20 Brightness  l Increase or decrease the brightness when capturing live images

21 Zoom 1X  l Reset to default zoom magnification (100%)

22 Reset  l Reset to factory default settings

Power adapter
Your document camera comes with a power adapter, including a country specific power cord (for EU, UK, 

and North America) that connects to the external power supply.

USB cable
Use the USB cable to connect your document camera to your computer. You can display objects, capture 

images to SMART Notebook files, and control your document camera from SMART Notebook software.

If you need to extend the USB connection, see the Troubleshooting and extending USB 2.0 and USB 3.0 

connection knowledge base article for guidance.

Wi-Fi dongle
Use the Wi-Fi dongle to connect your document camera to the network. 

See Using the HDMI method to connect on page 22.

https://www.smarttech.com/kb/171733
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Understanding Camera and PC modes
You can use your document camera in Camera or Computer Pass-Through (PC) mode. Each mode enables 

you to do different things and requires a specific connection to a display, projector, or computer. 

Camera mode
In Camera mode, you can view live images captured by the document camera:

 l In SMART Notebook software using the USB connection

 l In SMART Document Camera software using the USB or WiFI connection

 l On a display or projector using the HDMI out connection or Miracast (if the display or projector supports 

it)

Computer Pass-Through (PC) mode
PC mode enables you to view your computer’s desktop on a connected display or projector. In this mode, 

the document camera acts as a pass-through device between the computer and the display or projector.

To use this mode, connect an HDMI cable to your computer and then to the HDMI IN port on the document 

camera, then connect a second HDMI cable from the document camera’s HDMI OUT port to a display or 

projector.

NOTES 

 l The Capture button on the document camera’s control panel has no effect in PC mode.

 l In PC mode, you can view the document camera live image only in SMART Notebook software.

https://www.smarttech.com/kb/171733
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Features of each mode
The following table describes the differences between each mode. 

Feature Camera mode PC mode

View computer input No Yes

View document camera image Yes No

Control the document camera from a computer Yes No

Capture to SMART Notebook software Yes No

Access the related on-screen display menu Yes No 

Capture to a USB drive Yes No

https://www.smarttech.com/kb/171733
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Setting up your document camera
Before you use the SMART Document Camera, unfold and position it, then connect it to power to fully 

charge the battery. Before you connect the document camera to a device, install the software on the device. 

After the software’s installed, you can connect the document camera to that device.

To unfold and position your document camera

 1. Hold the handle of the document camera to 

stabilize it. 

 2. Lift the camera arm up, then pull the camera 

arm outward.

 3. Rotate the camera head and aim the lens at 

your object.

https://www.smarttech.com/kb/171733
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To connect your document camera to the power supply and charge the battery

 1. Connect the provided power supply cable to the DC port on the right connection panel.

NOTE 

Before you use the camera for the first time, charge the battery fully. The battery charge indicator on 

the front panel shows you the battery’s status. For more information about the battery charge 

indicator, see Battery charge indicator on page 12.

 2. Connect the power supply cable to a power outlet.

After the power is connected, the document camera enters Standby mode and starts charging.

Turning your document camera on and off
After you’ve completed the basic connections, you are ready to turn the document camera on for the first 

time. 

To turn on your document camera

  Press  on the control panel or the remote control until the power indicator light turns green.

To turn off your document camera

  Press  on the control panel or remote control for three seconds.

The power indicator light turns off.

NOTE 

If you press and hold the power button for less than three seconds, the document camera enters 

Standby mode and the power indicator light shines solid red.

https://www.smarttech.com/kb/171733
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Installing software for your document camera
Before you use your document camera, download the required software to get the most out of your 

document camera. Download and install the latest version of the following software before you connect your 

document camera to a device:

Software Supported operating systems or devices

SMART Notebook 20.1 or later (includes 
SMART Ink and Product Drivers)

 l Windows computer

 l Mac computer

NOTE 

Refer to SMART Notebook’s computer requirements 
for complete system requirements.

SMART Document Camera software  l Windows 

 l macOS

 l Android (including the iQ experience on 
SMART Board interactive displays)

To access downloads and installation instructions for the software on Windows and Mac operating systems, 

see support.smarttech.com//docs/redirect/?product=doccamera650&context=downloads.

The SMART Document Camera 650 Android app for SMART Board interactive displays with iQ is available 

from the iQ app store or from the Google Play store for other Android devices.

https://www.smarttech.com/kb/171733
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Connecting to a computer or display
There are a number of ways to connect your SMART Document Camera to a display device, such as a 

computer or SMART Board interactive display:

Method Description

USB Out Use this method if you will be using the document camera with a computer or a 
SMART Board interactive display with iQ.

NOTE 

This method is required if you plan to use the document camera with SMART Notebook 
software.

HDMI Out Use this method to connect directly to a display that has an HDMI port, such as a 
SMART Board interactive display. 

Wireless Use this method to connect to a Wi-Fi-enabled device, such as a computer or SMART Board 
interactive display, from anywhere in the classroom. There are three wireless connection 
methods:

 l Peer-to-Peer (P2P) (recommended)

 l Wi-Fi

 l Miracast

Read the sections below for the connection method you want to use.

IMPORTANT 

Before completing these procedures, make sure you install the required software.

https://www.smarttech.com/kb/171733
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Using the USB method to connect
Use the included USB cable to connect the document camera to a computer. 

To connect your document camera to a  computer with a USB cable

 1. Use the included USB cable to connect the USB B port on the document camera to a USB port on the 

computer:

TIP 

If you need to extend the USB connection, see Troubleshooting and extending USB 2.0 and USB 3.0 

connection.

 2. Press  on the control panel until the Wi-Fi indicator light is off.

 3. Turn the document camera on and then press Camera/PC  on the control panel or remote control.

 4. Open the SMART Document camera software or SMART Notebook software, depending on which 

application you want to use to display the document camera’s live images.
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Using the HDMI method to connect
Use the HDMI Out port to connect the document camera to a display. Using this method only displays the 

document camera’s live image on the connected display device. Use the remote control or control panel to 

change the picture (for example, zoom in, focus, freeze, and so on). If you want to record video or save 

captures of the live image, first attach a USB drive to the document camera.

To connect your document camera to a display device

 1. Connect the HDMI cable to the HDMI OUT port on the document camera’s rear connection panel.

 2. Locate the HDMI IN port on the display device and connect the HDMI cable.

 3. Press the Camera/PC button on the control panel or remote control to switch the video signal to the 

display device.

Using the P2P method to connect
You can use the included Wi-Fi dongle to create a direct Peer-to-Peer (P2P) wireless connection between 

the document camera and your computer. This direct connection enables you to quickly connect the 

document camera without having to enter a password to connect school’s network.

This is the easiest and recommended way to connect wirelessly.
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NOTES 

 l If you connect using P2P, the document camera’s built-in mic cannot be used to record sound. 

Instead, you must use the mic on the device you are connecting to for recording sound.

 l SMART Notebook software cannot be used with this connection method. To use the document 

camera with SMART Notebook, use a USB connection.

To connect using P2P

 1. Download and install the SMART Document Camera software.

IMPORTANT 

For macOS, this download includes a driver for the Wi-Fi dongle that must be installed separately on 

the computer.

 2. Connect the included Wi-Fi dongle to a USB port on your computer.

 3. Open the SMART Document Camera software.

You will see your document camera listed.

TIP 

Check the serial number on the bottom of the camera to find the camera name.

 4. Click .

 5. Click Next.
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 6. (Optional) Enter a name and password for the document camera. A name helps you identify the 

document camera more easily, while the password will prevent unwanted users from connecting to 

your document camera wirelessly. If no name is entered, a default name is used.

TIP 

You can change the name and password later by selecting the Info button for the document camera. 

See page 39.

 7. Click Done.

The connection should be complete in about 60 seconds. When connection is successful, the camera’s 

live image appears in the SMART Document Camera software.

To learn more about using the SMART Document Camera software’s controls, see page 39.

Using the Wi-Fi connection
The document camera has its own Wi-Fi which you can connect to directly from your device. 

To connect your document camera to a wireless network

 1. Download and install the SMART Document Camera software.

 2. Press  on the control panel.

The Wi-Fi indicator light turns blue.

 3. Open the SMART Document Camera software.

The software automatically detects available document cameras.

 4. Click  for the document camera you want to connect with.

A message appears asking if you want to set up Wi-Fi mode.
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 5. Click Yes.

You are prompted to select a Wi-Fi network to connect with.

 6. Select the network you want to use and enter its password.

 7. Click Connect.

 8. (Optional) Enter a name and password for the document camera. A name helps you identify the 

document camera more easily, while the password will prevent unwanted users from connecting to 

your document camera wirelessly. If no name is entered, a default name is used.

TIP 

You can change the name and password later by selecting the Info button for the document camera. 

See page 39.

 9. Click Done.

 10. After the document camera is connected, click .

The camera’s live image appears in the SMART Document Camera software.

To learn more about using the SMART Document Camera software’s controls, see page 39. 

Connecting your document camera to Miracast
If your computer or device you want to connect to supports Miracast, you can also set that up to quickly 

display images captured by the document camera to the device.

To connect your document camera to Miracast

 1. Press Info  on the control panel or remote control.

The on-screen (OSD) menu appears on your display.

 2. Use the right arrow button  on the remote control or  on the control panel to browse to the 

Wireless tab.

NOTE 

If the Wireless tab is disabled, the Wi-Fi mode is turned off. To turn it on, press the Wi-Fi button and 

wait for the indicator light on the document camera to turn blue.

 3. Browse to Mode and then press .
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 4. Select Miracast and then press .

The Miracast setup option is now available.

 5. Use the down arrow button  on the remote control or  on the control panel to browse to 

Miracast Setup and then press .

 6. Select your remote display from the list.

The camera’s image appears on the remote display’s screen after connecting.
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Using the on-screen display menu
Use the on-screen display (OSD) menu to adjust settings for your document camera in Camera mode.

The OSD has the following options:

Tab Options

Image The Image tab contains options for adjusting these live image settings:

 l Brightness

 l Contrast

 l Saturation

 l Preview Mode

 l Effect

 l Mirror

 l Exposure

 l White balance

Wireless The Wireless tab contains options for setting the wireless connection, such as AP, Wi-Fi, or Miracast.
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Tab Options

System The System tab contains a variety of system settings and information, including:

 l Language setting

 l Output Display resolution setting

 l Flicker (refresh rate) settings 

 l Information about the document camera (such as model, software version, and so on)

 l Reset to factory default

Browsing to the OSD menus and sub-menus in Camera mode

  Press Info  on the control panel or remote control to open the OSD menu. After the OSD menu is 

open, use the following controls on the remote control or control panel to navigate and make 

selections:

Press Info  on the control panel or remote control to exit the OSD menu.

Accessing the Image menu

 1. Set your document camera to Camera mode.

 2. Press Info  on the control panel or remote control.

The OSD menu appears.

 3. Browse to and select the Image tab.
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 4. Select the setting you want to adjust: 

Image setting options Description

Brightness Adjust the image brightness level manually.

Contrast Adjust the image contrast level manually.

Preview Mode Select a mode to use for displaying the live image from the camera:

 o Normal: This is the default mode. In most cases, Normal mode provides the best 
sharpness and color.

 o Motion: Increases the frame rate to make movement in the live image smoother.

 o High Quality: Provides the best image quality for your chosen shooting area and 
connected display.

 o Microscope: For use when using the microscope adapter with the document 
camera.

 o Macro: For use while capturing objects is 4" (10 cm) or less away from the 
document camera.

 o Infinity: For use while capturing objects that are more than 30" (80 cm) away from 
the document camera.

Effect Convert the image to color, black/white, or film negative.

Mirror Select to flip the image:

 o ON – displays a mirrored image.

 o OFF – displays a normal image.

Exposure Setup Select the exposure settings:

 o AUTO – automatically adjust the camera exposure.

 o MANUAL – manually adjust the camera exposure. When you select this option, 
the Manual Exposure setting becomes available. Select it to manually adjust the 
exposure.

White Balance Setup Select the White Balance settings for various light conditions:

 o AUTO – automatically adjust the white balance.

 o MANUAL –  manually adjust the red and blue color levels. When you select this 
option, the Manual White Balance Blue and Manual White Balance Red options 
become available for you to adjust.

Accessing the Wireless menu

 1. Set your document camera to Camera mode. 

 2. Press Info  on the control panel or remote control.

The OSD menu appears.

https://www.smarttech.com/kb/171733


Chapter 3
Using your document camera

smarttech.com/kb/171733 30

 3. Press the  button on the control panel or remote control to browse to the Wi-Fi tab.

Wireless setting options Description

Mode Choose a wireless mode to use for connecting the document camera 
to a computer or display. Options are:

 o AP

 o Wi-Fi

TIP 

The Wi-Fi option may appear disabled unless you have set up a 
wireless connection.

 o Miracast

Miracast Setup If you enable Miracast mode, select the device you want to connect to 
from this menu.

Accessing the System menu

 1. Set your document camera to Camera mode. 

 2. Press the Info  button on the control panel or remote control.

The OSD menu appears.

 3. Press the  button on the control panel or remote control to browse to the System tab. 

System setting options Description

Language Select or change the language.

https://www.smarttech.com/kb/171733


Chapter 3
Using your document camera

smarttech.com/kb/171733 31

System setting options Description

Output Display  o Set the resolution to display an image on the screen:

 o 1024 × 768

 o 1280 × 720

 o 1280 × 800

 o 1280 × 1024

 o 1600 × 1200

 o 1920 × 1080

 o Select TV System to switch between NTSC and PAL video 
systems.

NOTE 

This selection is disabled in TV output mode.

Flicker Select refresh rate:

 o 50 Hz

 o 60 Hz

Information Display the product information. 

Default Restore all the settings to the factory default settings. 

Using Camera mode to display objects and 
documents
When your document camera is connected to a projector, interactive display, or TV, you can display a full-

screen image from your document camera. You can also access features and settings in the on-screen 

display (OSD) menu.

IMPORTANT 

Your document camera must be connected to a display to use the OSD menu.

Using Camera mode

 1. Connect your document camera to a projector or flat-panel display with an HDMI cable.

 2. Press Camera/PC  on the control panel or remote control. 

The camera’s image appears on the display.
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Displaying printed documents
When you set your document camera to Camera mode, you can display documents. 

TIP 

Use the anti-glare sheet to reduce glare and optimize image quality. The anti-glare sheet is a special 

coated film that helps eliminate the glare you might encounter while displaying glossy objects, such as 

magazines and photos. Place the anti-glare sheet on top of an object to reduce reflected light.

To display documents

 1. Place your documents on the table.

 2. Adjust the document camera, and then aim its lens at your documents.

TIP 

To change the orientation of the lens, twist the control on the camera head.

 3. Press Auto Focus  on the control panel or remote control to adjust the focus. 

Displaying objects

 1. Press Camera/PC  on the control panel or remote control.

 2. Place the object, such as a document or a model, you want to display under the camera. 

 3. Rotate the camera head to aim the lens at your object.

 4. If the image is too dark, press Lamp  on the control panel or remote control.

Rotating and mirroring the image

To rotate the image

  Adjust the camera head to the desired shooting area, and press Rotate  on the remote control to 

rotate the image 180° or twist the control on the camera’s head to rotate the image 90°.
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To mirror the image

 1. Press Info  on the control panel or remote control to open the OSD menu.

 2. Select Image.

 3. Browse to and select MIRROR.

 4. Select ON.

 5. Press Info  again to exit the OSD menu.

Changing the picture mode or adding an effect
Using the remote control or OSD menu, you can change the image mode used to capture the object or 

document. You can also use the OSD menu to add an effect, such as switching the image to black and white 

or negative.

To change the picture mode

 1. Press Mode  on the remote control to switch between picture modes.

OR

Press Info  on the control panel or remote control to open the OSD menu, select Image > Preview 

Mode, and then select the mode you want.

Both methods provide the following options for image mode:

 o Normal: This is the default mode. In most cases, Normal mode provides the best sharpness and 

color.

 o Motion: Increases the frame rate to make movement in the live image smoother.

 o High Quality: Provides the best image quality for your chosen shooting area and connected 

display.

 o Microscope: For use when using the microscope adapter with the document camera.

 o Macro: For use while capturing objects is 4" (10 cm) or less away from the document camera.

 o Infinity: For use while capturing objects that are more than 30" (80 cm) away from the document 

camera.
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To add an effect

 1. Press Info  on the control panel or remote control to open the OSD menu, navigate to Image > 

Effect, and then select the effect you want to add:

 o Color

 o B/W (Black and white)

 o Film negative

 2. Press Info  again to exit the OSD menu.

Capturing images and videos to a USB drive
Use the USB port on the SMART Document Camera to save images and videos to a USB drive. To do this, 

set your document camera to Camera mode and connect a USB drive to the document camera.

TIP 

You can also capture images and videos to your computer using SMART Notebook or SMART Document 

Camera 650 software.

Then, using the remote control or document camera’s control panel, press the Capture  button to save 

an image, or press the or Record  button to start recording video. Press the Record  button again to 

stop recording. When you are ready to view the files, connect the USB drive to a computer or interactive 

display.
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Using a microscope with your document camera
Connect your document camera to a microscope to examine microscopic objects on a bigger screen.

Connecting your document camera to a microscope

 1. Select the appropriate rubber coupler size for the microscope eyepiece and insert it in the microscope 

adapter.

 2. Attach the microscope adapter to the document camera and tighten the three bolts until the adapter is 

secured.

IMPORTANT 

Make sure the arrow on the camera head and microscope adapter are on the same side. 
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 3. Attach the microscope adapter to the microscope's eyepiece and then connect the document camera 

to the microscope.

 4. Turn the microscope adapter counterclockwise to line up the arrows and lock the microscope adapter 

in place.

 

To optimize microscope images

 1. Press Info  on the control panel or remote control to open the on-screen display (OSD) menu.

 2. Select the Image tab.

 3. Browse to the Preview Mode sub-menu and press .

 4. Select Microscope and press .

 5. Adjust and aim the camera head at the furthest point, and then press the AUTO FOCUS button on the 

control panel or remote control.

 6. Adjust the microscope’s focus as needed.

Displaying a microscope slide

 1. Place a slide or object on the stage of the microscope.

 2. Focus the microscope so that the subject is sharp.
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 3. Position the microscope under your document camera so the camera lens is aligned with the 

microscope eyepiece.

CAUTION 

Ensure you do not hit your document camera lens with the microscope. This could damage your 

document camera’s lens.

 4. Press the CAMERA/PC  button on the control panel or remote control so that the document camera 

is in Camera mode.

 5. Press Info  on the control panel or remote control to open the on-screen display (OSD) menu.

 6. Select the Image tab.

 7. Navigate to the Preview Mode sub-menu, and press .

 8. Select Microscope and press .

Using Miracast to view images on a display
If you’re using a display that supports Miracast, you can use Miracast to wirelessly share the images 

captured by the SMART Document Camera 650 to the display.

To use Miracast to share live images from the document camera

 1. Press Info  on the control panel or remote control.

The on-screen (OSD) menu appears on your display.

 2. Use the right arrow button  on the remote control or  on the control panel to browse to the 

Wireless tab.

NOTE 

If the Wireless tab is disabled, the Wi-Fi mode is turned off. To turn it on, press the Wi-Fi button and 

wait for the indicator light on the document camera to turn blue.

 3. Browse to Mode and then press .

 4. Select Miracast and then press .

The Miracast setup option is now available.

 5. Use the down arrow button  on the remote control or  on the control panel to browse to 

Miracast Setup and then press .
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 6. Select your remote display from the list.

The camera’s image appears on the remote display’s screen after connecting.
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Chapter 4: Using the SMART Document Camera 
650 software

Downloading the software 40
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Viewing saved images and videos in the library 45

Adding images or videos to your library from other sources (Windows only) 46

You can use the SMART Document Camera software to view live images from the document camera to a 

device connected through a USB or wireless connection. When you first open the SMART Document 

Camera 650 software, you will see the following main window with the following features:
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Downloading the software
To download the software for Windows and Mac operating systems, visit 

support.smarttech.com//docs/redirect/?product=doccamera650&context=downloads.

For SMART Board interactive displays with iQ, visit the iQ app store on the display to download the software 

for Android.

Viewing a document camera’s live image
When you open the SMART Document Camera 650 software, you will see the available cameras you can 

connect to. If there are multiple cameras are listed, you can filter the list or add a document camera to your 

favorites. 
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To connect to an available camera

 1. Open the SMART Document Camera 650 software. 

 2. Find the document camera you want to connect to and select .

TIPS 

 o If you use the document camera often, select  to save it to your favorites list for quicker 

connection in the future. 

 o Select Filter and select In my classroom to view a local list of available wireless cameras.

NOTE 

If you are trying to connect to a wireless camera, you may need to select  before you can start 

viewing the live image.

The live stream window opens, showing the live image from the document camera.

To add and connect to a document camera manually using its IP address

 1. Open the On-screen display menu for the document camera.

 2. Navigate to the System > Information tab to find the IP address.
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 3. In the SMART Document Camera 650 software, select Add Camera .

The Add Document Camera dialog box opens.

 4. Enter the document camera’s IP address and select Next.

When the connection is successful, the Save Camera screen appears.

 5. (Optional) Enter a name and password for the document camera. A name helps you identify the 

document camera more easily, and the password will prevent unwanted users from connecting to your 

document camera wirelessly. If you don’t enter a name, the document camera’s serial number is used.

 6. Click Done.

Using the software to control the live image
When you view the live image from a connected document camera, the following controls appear:
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No. Description

1 Closes the live image viewer.

2 Freezes the document camera’s live image. Select again to unfreeze.

3 Opens the drawing tools to annotate over the live image.

4 Takes a screen capture of the entire live image.

5 Opens the video recording tools:

 l Select the microphone to mute or unmute the microphone.

 l Select Record to begin the recording.

 l Select the pause button to pause the recording. 

 l Select Stop to end the recording.

6 Takes a screen capture of a selected section of the live image.
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No. Description

7 Opens the focus controls:

8 Enters split-screen mode to view images side-by-side with the document camera’s live image. 

Click Add File to browse to an image saved on your device and add it to your split-screen bar at the 
bottom of the window:

Then select the images you want to view alongside the live image, then click the check mark.

To stop split-screen mode, clear the selection of all the images you previously selected, then click 
the check mark to apply the changes.

Click the X in the split-screen bar to close it.

9 Rotates the live image.
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No. Description

10 Accesses the zoom and panning controls:

11 Opens the document camera’s settings. .

Changing settings
From the settings menu, you can change settings for the camera, display, recordings, and network usage 

options.

Tab Settings

Camera Adjust resolution and the document camera’s image mode and image frequency.

Display Select the tools you want to appear in the toolbar, such as Freeze, Annotate, Screen shot, 
and so on.

Record Choose settings for video recording and screen captures, such as:

 l video format and quality

 l location for saved video and image files on your device

 l microphone settings

 l image file format

Advanced Adjust the usage rate for network bandwidth.

Viewing saved images and videos in the library
Recordings or screen captures you take using the SMART Document Camera 650 software are saved to the 

Library, which is synchronized with your device’s local drive. To view saved images and videos, open the 

Library tab. Then select either the Image or Video folder to see saved files.
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TIP 

Saved files and videos can be used during split screen mode to show side-by-side with the live image.

 Adding images or videos to your library from other sources (Windows only)
When using the SMART Document Camera 650 software on a Windows computer, you can add and export 

images and videos in the software’s library.

To add images or videos on a Windows computer

 1. Open Windows’ File Explorer.

 2. For images, browse to Pictures > SMART Document Camera 650 software .

OR

For videos, browse to Videos > SMART Document Camera 650 software.

 3. Copy the files you want to a new location.

To export images or videos on a Windows computer

 1. Open Windows’ File Explorer.

 2. For images, browse to Pictures > SMART Document Camera 650 software .

OR

For videos, browse to Videos > SMART Document Camera 650 software.

 3. Copy the files you want to a new location.
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Chapter 5: Using with SMART Notebook software

Connecting to SMART Notebook 47
Using the Document Camera Viewer in SMART Notebook 49

Use SMART Notebook software to save images and then present them later. If your computer is connected 

to an interactive whiteboard, projector, or television, you can deliver your SMART Notebook presentation 

with live images from your document camera.

Connecting to SMART Notebook
The document camera is compatible only with SMART Notebook software using the USB connection mode.

To connect to the computer and turn on USB connection mode

 1. Connect the document camera to the computer using the included USB cable.

 2. Turn the document camera on and then press Camera/PC  on the control panel or remote control.

 3. On the computer, open SMART Notebook.
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 4. From the Notebook menu, select Insert > SMART Document Camera Viewer. 

OR 

If you are using the 4K Notebook presenter, select View > 4K presenter > Insert > SMART Document 

Camera Viewer.

The SMART Document Camera Viewer window opens in the Notebook page: 
The regular SMART Document Camera Viewer 

window in SMART Notebook:

The SMART Document Camera Viewer window 

in 4K presenter:

 

NOTE 

The 4K presenter is recommended to use when you are connected to a 4K display device so that you 
ensure the best picture quality. Otherwise, the controls and features are the same.
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Using the Document Camera Viewer in 
SMART Notebook
The SMART Document Camera viewer includes the following controls and features:

No. Description

1 This area shows the document camera’s live image.

2 There are three image capture controls:

 l Capture and Close: Use this to capture the current live image and insert it on the current 
SMART Notebook page. This will also close the SMART Document Camera viewer.

 l Capture to New Page: Use this to capture the current live image and insert it on a new 
SMART Notebook page.

 l Capture with Time-Lapse: Use this to capture a time-lapse of the document camera’s live 
image. You can choose a duration for the time-lapse recording.

NOTE 

If you press the Capture  button on the document camera’s control panel or remote control, it 
saves the live image to the SMART Notebook page and closes the SMART Document Camera 
viewer. Pressing the Capture button again re-opens the SMART Document Camera viewer. 

3 Use these controls to zoom in or out on the live image.

4 Use these controls to increase or decrease the brightness of the live image.

5 Use these controls to adjust the focus. You can select Auto-Focus, Focus Out, and Focus In.
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No. Description

6 Select this control to view the following additional settings for changing the live image’s 
appearance:

 l Rotate 180°

 l Convert to color

 l Convert to black and white

 l Convert to negative

 l Convert to positive
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